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Preface

This preface contains the following topics:

■ Intended Audience

■ Documentation Accessibility

■ Organization

■ Related Documentation

■ Conventions
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Intended Audience
This guide is intended for those who perform the following tasks:

■ Install applications

■ Maintain applications

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation

accessible, with good usability, to the disabled community. To that end, our

documentation includes features that make information available to users of

assistive technology. This documentation is available in HTML format, and contains

markup to facilitate access by the disabled community. Standards will continue to

evolve over time, and Oracle Corporation is actively engaged with other

market-leading technology vendors to address technical obstacles so that our

documentation can be accessible to all of our customers. For additional information,

visit the Oracle Accessibility Program Web site at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation JAWS, a Windows screen

reader, may not always correctly read the code examples in this document. The

conventions for writing code require that closing braces should appear on an

otherwise empty line; however, JAWS may not always read a line of text that

consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This

documentation may contain links to Web sites of other companies or organizations

that Oracle Corporation does not own or control. Oracle Corporation neither

evaluates nor makes any representations regarding the accessibility of these Web

sites.

Organization
This document contains:

Chapter 1, "Introduction"
This chapter describes the PeopleSoft 8 adapter and the hardware and software

requirements.
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Chapter 2, "Installation and Configuration"
This chapter describes installation and configuration of the PeopleSoft 8 adapter

Chapter 3, "Supported PeopleSoft 8 Component Interfaces"
This chapter provides PeopleSoft-specific information for accessing PeopleSoft

Component Interfaces using Oracle Application Server InterConnect (OracleAS

InterConnect).

Chapter 4, "Component Interface Methods"
This chapter provides information on OracleAS InterConnect PeopleSoft 8 adapter’s

Component Interface standard and user-defined methods.

Chapter 5, "Importing the Custom Component Interface"
This chapter provides instructions for adding a custom Component Interface into a

PeopleSoft server.

Chapter 6, "Using the Configuration Editor"
This chapter provides runtime concepts for the PeopleSoft 8 adapter.

Related Documentation
For more information, see these Oracle resources:

■ Oracle Application Server InterConnect User’s Guide

■ Oracle Application Server InterConnect Installation Guide

■ Oracle Application Server InterConnect Adapter Configuration Editor User’s Guide

In North America, printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/

Customers in Europe, the Middle East, and Africa (EMEA) can purchase

documentation from

http://www.oraclebookshop.com/

Other customers can contact their Oracle representative to purchase printed

documentation.
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To download free release notes, installation documentation, white papers, or other

collateral, please visit the Oracle Technology Network (OTN). You must register

online before using OTN; registration is free and can be done at

http://otn.oracle.com/admin/account/membership.html

If you already have a username and password for OTN, then you can go directly to

the documentation section of the OTN Web site at

http://otn.oracle.com/docs/index.htm

Conventions
This section describes the conventions used in the text and code examples of this

documentation set. It describes:

■ Conventions in Text

■ Conventions in Code Examples

■ Conventions for Microsoft Windows Operating Systems
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Conventions in Text
We use various conventions in text to help you more quickly identify special terms.

The following table describes those conventions and provides examples of their use.

Convention Meaning Example

Bold Bold typeface indicates terms that are
defined in the text or terms that appear in
a glossary, or both.

When you specify this clause, you create an
index-organized table.

Italics Italic typeface indicates book titles or
emphasis.

Oracle9i Database Concepts

Ensure that the recovery catalog and target
database do not reside on the same disk.

UPPERCASE
monospace
(fixed-width)
font

Uppercase monospace typeface indicates
elements supplied by the system. Such
elements include parameters, privileges,
datatypes, RMAN keywords, SQL
keywords, SQL*Plus or utility commands,
packages and methods, as well as
system-supplied column names, database
objects and structures, usernames, and
roles.

You can specify this clause only for a NUMBER
column.

You can back up the database by using the
BACKUP command.

Query the TABLE_NAME column in the USER_
TABLES data dictionary view.

Use the DBMS_STATS.GENERATE_STATS
procedure.

lowercase
monospace
(fixed-width)
font

Lowercase monospace typeface indicates
executables, filenames, directory names,
and sample user-supplied elements. Such
elements include computer and database
names, net service names, and connect
identifiers, as well as user-supplied
database objects and structures, column
names, packages and classes, usernames
and roles, program units, and parameter
values.

Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase.
Enter these elements as shown.

Enter sqlplus  to open SQL*Plus.

The password is specified in the orapwd  file.

Back up the datafiles and control files in the
/disk1/oracle/dbs  directory.

The department_id , department_name ,
and location_id  columns are in the
hr.departments  table.

Set the QUERY_REWRITE_ENABLED
initialization parameter to true.

Connect as oe  user.

The JRepUtil  class implements these
methods.

lowercase
italic
monospace
(fixed-width)
font

Lowercase italic monospace font
represents placeholders or variables.

You can specify the parallel_clause .

Run Uold_release .SQL  where old_
release refers to the release you installed
prior to upgrading.
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Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line

statements. They are displayed in a monospace (fixed-width) font and separated

from normal text as shown in this example:

SELECT username FROM dba_users WHERE username = ’MIGRATE’;

The following table describes typographic conventions used in code examples and

provides examples of their use.

Convention Meaning Example

[ ] Brackets enclose one or more optional
items. Do not enter the brackets.

DECIMAL ( digits  [ , precision  ])

{ } Braces enclose two or more items, one of
which is required. Do not enter the
braces.

{ENABLE | DISABLE}

| A vertical bar represents a choice of two
or more options within brackets or braces.
Enter one of the options. Do not enter the
vertical bar.

{ENABLE | DISABLE}

[COMPRESS | NOCOMPRESS]

... Horizontal ellipsis points indicate either:

■ That we have omitted parts of the
code that are not directly related to
the example

■ That you can repeat a portion of the
code

CREATE TABLE ... AS subquery ;

SELECT col1 , col2 , ... , coln  FROM
employees;

 .

 .

 .

Vertical ellipsis points indicate that we
have omitted several lines of code not
directly related to the example.

Other notation You must enter symbols other than
brackets, braces, vertical bars, and ellipsis
points as shown.

   acctbal NUMBER(11,2);

   acct    CONSTANT NUMBER(4) := 3;

Italics Italicized text indicates placeholders or
variables for which you must supply
particular values.

CONNECT SYSTEM/system_password

DB_NAME = database_name
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Conventions for Microsoft Windows Operating Systems
The following table describes conventions for Microsoft Windows operating

systems and provides examples of their use.

UPPERCASE Uppercase typeface indicates elements
supplied by the system. We show these
terms in uppercase in order to distinguish
them from terms you define. Unless terms
appear in brackets, enter them in the
order and with the spelling shown.
However, because these terms are not
case sensitive, you can enter them in
lowercase.

SELECT last_name, employee_id FROM
employees;

SELECT * FROM USER_TABLES;

DROP TABLE hr.employees;

lowercase Lowercase typeface indicates
programmatic elements that you supply.
For example, lowercase indicates names
of tables, columns, or files.

Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase.
Enter these elements as shown.

SELECT last_name, employee_id FROM
employees;

sqlplus hr/hr

CREATE USER mjones IDENTIFIED BY
ty3MU9;

Convention Meaning Example

Choose Start > How to start a program. To start the Oracle Database Configuration
Assistant, choose Start > Programs > Oracle -
HOME_NAME > Configuration and Migration
Tools > Database Configuration Assistant.

File and directory
names

File and directory names are not case
sensitive. The following special characters
are not allowed: left angle bracket (<),
right angle bracket (>), colon (:), double
quotation marks ("), slash (/), pipe (|),
and dash (-). The special character
backslash (\) is treated as an element
separator, even when it appears in quotes.
If the file name begins with \\, then
Windows assumes it uses the Universal
Naming Convention.

c:\winnt"\"system32  is the same as
C:\WINNT\SYSTEM32

Convention Meaning Example
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C:\> Represents the Windows command
prompt of the current hard disk drive.
The escape character in a command
prompt is the caret (^). Your prompt
reflects the subdirectory in which you are
working. Referred to as the command
prompt in this manual.

C:\oracle\oradata>

The backslash (\) special character is
sometimes required as an escape
character for the double quotation mark
(") special character at the Windows
command prompt. Parentheses and the
single quotation mark (’) do not require
an escape character. Refer to your
Windows operating system
documentation for more information on
escape and special characters.

C:\>exp scott/tiger TABLES=emp
QUERY=\"WHERE job=’SALESMAN’ and
sal<1600\"

C:\>imp SYSTEM/ password
FROMUSER=scott TABLES=(emp, dept)

HOME_NAME Represents the Oracle home name. The
home name can be up to 16 alphanumeric
characters. The only special character
allowed in the home name is the
underscore.

C:\> net start Oracle HOME_
NAMETNSListener

Convention Meaning Example



xvii

ORACLE_HOME
and ORACLE_
BASE

In releases prior to Oracle8i release 8.1.3,
when you installed Oracle components,
all subdirectories were located under a
top level ORACLE_HOME directory that by
default used one of the following names:

■ C:\orawin95  for Windows 95

■ C:\orawin98  for Windows 98

This release complies with Optimal
Flexible Architecture (OFA) guidelines.
All subdirectories are not under a top
level ORACLE_HOME directory. There is a
top level directory called ORACLE_BASE
that by default is C:\oracle . If you
install Oracle9i release 1 (9.0.1) on a
computer with no other Oracle software
installed, then the default setting for the
first Oracle home directory is
C:\oracle\ora90 . The Oracle home
directory is located directly under
ORACLE_BASE.

All directory path examples in this guide
follow OFA conventions.

Go to the ORACLE_BASE\ ORACLE_
HOME\rdbms\admin  directory.

Convention Meaning Example
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1
Introduction

This document describes how to use Oracle Application Server InterConnect

(OracleAS InterConnect) Adapter for PeopleSoft 8 (PeopleSoft 8 adapter).

This chapter discusses the following topics:

■ System Requirements

■ PeopleSoft Component Interfaces

■ Supported PeopleSoft Version

■ Supported Operating Systems
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System Requirements
The PeopleSoft 8 adapter has the following system requirements:

■ psjoa.jar —To use Component Interfaces, you must have access to the

PeopleSoft’s Component Interface file, psjoa.jar , located in the

<PeopleSoft_Installation_Directory >\web\PSJOA\  directory.

■ For design time browsing of Component Interfaces, this file must be present

in the CLASSPATH variable defined in the iStudio.bat  file.

■ For runtime use of Component Interfaces, this file must be present in the

service_classpath  variable defined in the adapter.ini  file for

Windows platforms or the classpath in the start script for Unix platforms.

■ Before using Component Interfaces, you must import a custom Component

Interface.

PeopleSoft Component Interfaces
PeopleSoft Component Interfaces contain tables and data formats for specific tasks.

The PeopleSoft software is used for tasks, such as, manufacturing, human resources,

accounting, and supply chain management.

Supported PeopleSoft Version
The PeopleSoft 8 adapter connects to the PeopleSoft Component Interface, Version

8.17.02.

See Also: "Importing the Custom Component Interface"  on

page 5-1

Note: OracleAS InterConnect can read data from the PeopleSoft

server correctly. However, creating and updating PeopleSoft data

containing properties with collections will fail.
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Supported Operating Systems
Table 1–1 lists the supported operating systems for the PeopleSoft 8 adapter.

Table 1–1 Operating System Requirements

Operating System Version

Windows NT Version 4.0 with service pack 6 or above

Windows 2000 With service pack 1 or above

HP-UX 11.6 (64 bit)

Sun SPARC Solaris 8 (32 bit)
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2
Installation and Configuration

This chapter describes how to install and configure the PeopleSoft 8 adapter. It

contains the following topics:

■ Installing the PeopleSoft 8 Adapter

■ Configuring the PeopleSoft 8 Adapter

■ Starting the PeopleSoft 8 Adapter

■ Stopping the PeopleSoft 8 Adapter
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Installing the PeopleSoft 8 Adapter
This section contains these topics:

■ Preinstallation Tasks

■ Installation Tasks

Preinstallation Tasks
The PeopleSoft 8 adapter must be installed in one of the following Oracle homes:

■ An existing OracleAS InterConnect Oracle home for this release

■ A new Oracle home (the installer creates this for you)

Consult the following guides before proceeding with the PeopleSoft 8 adapter

installation:

■ Oracle Application Server InterConnect Installation Guide, which includes

information on:

■ Oracle Universal Installer startup

■ CD-ROM mounting

■ OracleAS InterConnect installation

■ Oracle Application Server InterConnect User’s Guide, which includes information

on:

■ OracleAS InterConnect software, hardware, and system requirements

Installation Tasks
To install the PeopleSoft 8 adapter:

1. On the Available Product Components page of the OracleAS InterConnect

installation, select PeopleSoft 8 adapter, then select Next.

Consider the following scenarios:

Note: OracleAS InterConnect Hub is installable through the

OracleAS InterConnect Hub installation type. You must install the

OracleAS InterConnect Hub before proceeding with the PeopleSoft

8 adapter installation.
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■ If installing the PeopleSoft 8 adapter in an independent Oracle home, make

sure that the OracleAS InterConnect Hub has been installed, not necessarily

in the same Oracle home. Continue to step 2.

■ If installing the PeopleSoft 8 adapter in an existing Oracle home, make sure

that it is a home directory to one of the OracleAS InterConnect components.

Continue to step 3.

2. If installing OracleAS InterConnect for the first time on this machine, complete

the following steps to enter the hub database information:

a. On the Welcome page, select Next. The Database Configuration page

displays. Enter information in the following fields:

* Host Name—The host name of the machine where the hub database is

installed.

* Port Number—The TNS listener port for the hub database.

* Database SID—The SID for the hub database.

b. Click Next. The Database User Configuration page displays. Enter

information in the following fields:

* User Name—The hub database user name. Make sure the OracleAS

InterConnect Hub is installed. If the Hub is not installed, complete the

installation and note the user name and password.

* Password—The password for the hub database user.

3. Click Next. The Adapter Configuration page displays. Enter the application to

be defined or already defined in iStudio in the Application Name field. White

spaces or blank spaces are not permitted. The default value is myPSFT8App.

Note: The hub database information, such as the SID, host, port,

and username/password from the Hub installation, is needed for

step 2.
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4. Click Next. The installation page that displays next depends on the operating

system:

5. Enter information in the following fields on the Specify PeopleSoft and Tuxedo

Install Locations page:

■ PeopleSoft Installation Path—The root directory for the PeopleSoft

installation. The default is:

/opt/PeopleSoft

■ Tuxedo Installation Path—The root directory for the Tuxedo installation.

The default is:

/opt/tuxedo

6. Enter the client binaries location on the Specify PeopleSoft Client Binaries

Location page.

7. Click Next. Complete the fields for any other components selected for

installation, such as other adapters. When finished, the Summary page displays.

8. Click Install to install the PeopleSoft 8 adapter and other selected components.

The PeopleSoft 8 adapter is installed in the following directory:

9. Click Exit at the End of Installation page to exit the PeopleSoft 8 adapter

installation.

On... Then Go to Step...

UNIX 5

Windows 6

Platform Directory

Windows %ORACLE_HOME%\oai\9.0.4\adapters\ Application

UNIX $ORACLE_HOME/oai/9.0.4/adapters/ Application
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Configuring the PeopleSoft 8 Adapter
Table 2–2, Table 2–3, and Table 2–4 describe executable files, configuration files, and

directories. These files and directories are accessible from the directory shown in

Table 2–1:

Table 2–1 PeopleSoft 8 Adapter Directory

On... Go to...

UNIX $ORACLE_HOME/oai/9.0.4/adapters/ Application

Windows %ORACLE_HOME%\oai\9.0.4\adapters\ Application

Table 2–2 Executable Files

File Description

start.bat  (Windows) Takes no parameters, starts the adapter.

start  (UNIX) Takes no parameters, starts the adapter.

stop.bat  (Windows) Takes no parameters, stops the adapter.

stop  (UNIX) Takes no parameters, stops the adapter.

ignoreErrors.bat
(Windows)

If an argument is specified, then the given error code will be
ignored. If no argument is specified, then all error codes
specified in the ErrorCodes.ini  will be ignored.

ignoreErrors  (UNIX) If an argument is specified, then the given error code will be
ignored. If no argument is specified, then all error codes
specified in the ErrorCodes.ini  will be ignored.

Table 2–3 Configuration Files

File Description

ErrorCodes.ini
(Windows and UNIX)

Contains one error code per line.

adapter.ini  (Windows
and UNIX)

Consists of all the initialization parameters which the adapter
reads at startup. Refer to Appendix A for a typical
adapter.ini  file.
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Using the Application Parameter
Adapters do not have integration logic. The PeopleSoft 8 adapter has a generic

transformation engine that processes metadata from the repository as runtime

instructions to do transformations. The application defines for an adapter what its

capabilities are. For example, it can define what messages it can publish, what

messages it can subscribe to, and what are the transformations to perform. The

application parameter allows the adapter to become smart in the context of the

application to which it is connected. It allows the adapter to retrieve from the

repository only that metadata that is relevant to the application. The application

parameter must match the corresponding application that will be defined in iStudio

under the Applications folder.

If you are using pre-packaged metadata, after importing the pre-packaged metadata

into the repository, start up iStudio to find the corresponding application (under the

Applications folder in iStudio) to use as the application for the adapter you are

installing (unless the package you are using provides directions for what the

application should be).

Adapter.ini Initialization Parameter File Settings
This section contains these topics:

■ Hub.ini Parameters

■ Real Application Clusters-specific Hub.ini Parameters

■ Agent Connection Parameters

■ PeopleSoft 8 Adapter Parameters

Table 2–4 Directories

File Description

persistence The messages are persisted in this directory. You should not
edit the directory or its contents.

logs The logging of adapter activity is done in subdirectories of the
log directory. Each new run of the adapter creates a new
subdirectory in which logging is done in an oailog.txt  file.
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Hub.ini Parameters
The PeopleSoft 8 adapter connects to the hub database using parameters from the

hub.ini  file located in the hub directory. The following table lists the parameter

name, a description for each parameter, the possible and default values, and an

example.

Real Application Clusters-specific Hub.ini Parameters
When a hub is installed on a Real Application Clusters (RAC) database, parameters

listed in Table 2–6 represent information on additional nodes used for connection

and configuration. These parameters are added on top of the default parameters

which represent the primary node. In Table 2–6, x  represent the node number,

which varies between 2 and the number of nodes. For example, if the Real

Application Clusters setup contains 4 nodes, x  can take a value between 2 and 4.

Table 2–5 Hub.ini Parameters

Parameter Description Example

hub_username The name of the hub database schema (or username).
The default value is oaihub904 .

hub_username=oaihub904

hub_password The password for the hub database user. There is no
default value. You input the hub_password  value
during installation.

hub_password=manager

hub_host The name of the machine hosting the hub database.
There is no default value. You input the hub_host
value during installation.

hub_host=mpmypc

hub_instance The system identification number (SID) of the hub
database. There is no default value. You input the hub_
instance  value during installation.

hub_instance=orcl

hub_port The transparent network services (TNS) listener port
number for the HUB database instance. There is no
default value. You input the hub_port  value during
installation.

hub_port=1521

repository_name The valid name of the repository this adapter talks to.
The default value is InterConnectRepository .

repository_
name=InterConnectRepos
itory
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Agent Connection Parameters
The PeopleSoft 8 adapter connects to the spoke application using parameters from

the adapter.ini  file. The following table lists the parameter name, description,

the possible and default values, and example for each parameter.

Table 2–6 Real Application Cluster-specific hub.ini Parameters

Parameter Description Example

hub_num_nodes Number of nodes in Real Application Clusters. hub_num_nodes=4

hub_host x The host where the Real Application Clusters database is
installed.

hub_host2=dsunram13

hub_instance x The instance on the respective node. hub_instance2=orcl2

hub_port x The port on which the listener is listening. hub_port2=1521

Table 2–7 Adapter.ini Parameters

Parameter Description Example

application The name of the application this adapter connects to.
This must match with the name specified in iStudio
during creating of metadata. Any alphanumeric string
can be used. There is no default value.

application=aqapp

partition The partition this adapter handles as specified in iStudio.
Any alphanumeric string is a possible value. There is no
default value.

partition=germany

instance_number To have multiple adapter instances for the given
application with the given partition, each adapter should
have a unique instance number. Possible values are any
integer greater than 1. There is no default value.

instance_number=1

agent_log_level The amount of logging. Possible values are:

0=errors only

1=status and errors

2=trace, status, and errors

The default value is 1.

agent_log_level=2

agent_
subscriber_name

The subscriber name used when this adapter registers its
subscription. The possible value is a valid Oracle
Advanced Queuing subscriber name. There is no default
value.

agent_subscriber_
name=aqapp
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agent_message_
selector

Specifies conditions for message selection when
registering its subscription with the hub. The possible
value is a valid Oracle Advanced Queuing message
selector string. There is no default value.

agent_message_
selector=recipient_
list like’%aqapp,%’

agent_reply_
subscriber_name

The subscriber name used when multiple adapter
instances for the given application with the given
partition are used. Optional if there is only one instance
running. The possible value is application name
(parameter: application ) concatenated with
instance number (parameter: instance_number ).
There is no default value.

If application=aqapp,
instance_number=2 ,
then, agent_reply_
subscriber_
name=aqapp2

agent_reply_
message_selector

Used only if multiple adapter instances for the given
application with the given partition. The possible value
is a string built using concatenating application name
(parameter:application ) with instance number
(parameter:instance_number ). There is no default
value.

If application=aqapp,
instance_number=2 ,
then agent_reply_
message_
selector=receipient_
list like
’%,aqapp2,%’

agent_tracking_
enabled

Specifies if message tracking is enabled. Set to false  to
turn off all tracking of messages. Set to true  to track
messages with tracking fields set in iStudio. The default
value is true .

agent_tracking_
enabled=true

agent_
throughput_
measurement_
enabled

Specifies if throughput measurement is enabled. Set to
true  to turn on all throughput measurements. The
default value is true .

agent_throughput_
measurement_
enabled=true

agent_use_
custom_hub_dtd

Specifies if a custom data type definition (DTD) should
be used for the common view message when handing it
to the hub. By default, adapters use an OracleAS
InterConnect-specific DTD for all messages sent to the
hub as other OracleAS InterConnect adapters will be
retrieving the messages from the hub and know how to
interpret them. Set to true  if you want to use the DTD
import for every message of the common view. Only set
to true  if a OracleAS InterConnect adapter is not
receiving the messages from the hub. There is no default
value.

agent_use_custom_hub_
dtd=false

Table 2–7 Adapter.ini Parameters

Parameter Description Example
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agent_metadata_
caching

Specifies the metadata caching algorithm. Possible
values are:

■ startup —Cache everything at startup. This may
take a while if there are many tables in the
repository.

■ demand—Cache metadata as it is used.

■ none —No caching. This slows down performance.

The default value is demand.

agent_metadata_
caching=demand

agent_dvm_table_
caching

Specifies the domain value mapping (DVM) caching
algorithm. Possible values are:

■ startup —Cache all DVM tables at startup. This
may take a while if there are a lot of tables in the
repository.

■ demand—Cache tables as they are used.

■ none —No caching. This slows down performance.

The default value is demand.

agent_dvm_table_
caching=demand

agent_lookup_
table_caching

Specifies the lookup table caching algorithm. Possible
values are:

■ startup —Cache all lookup tables at startup. This
may take a while if there are a lot of tables in the
repository.

■ demand—Cache tables as they are used.

■ none —No caching. This slows down performance.

The default value is demand.

agent_lookup_table_
caching=demand

agent_delete_
file_cache_at_
startup

With any of the agent caching methods enabled,
metadata from the repository is cached locally on the file
system.

Set this parameter to true  to delete all cached metadata
on startup.

Note: After changing metadata or DVM tables for this
adapter in iStudio, you must delete the cache to
guarantee access to the new metadata or table
information.

The default value is false .

agent_delete_file_
cache_at_
startup=false

Table 2–7 Adapter.ini Parameters

Parameter Description Example
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agent_max_ao_
cache_size

Specifies the maximum number of application objects’
metadata to cache. Possible values are any integer
greater than 1. The default value is 200 .

agent_max_ao_cache_
size=200

agent_max_co_
cache_size

Specifies the maximum number of common objects’
metadata to cache. Possible values are any integer
greater than 1. The default value is 100 .

agent_max_co_cache_
size=100

agent_max_
message_
metadata_cache_
size

Specifies the maximum number of messages’ metadata
to cache (publish/subscribe and invoke/implement).
Possible values are any integer greater than 1. The
default value is 200 .

agent_max_message_
metadata_cache_
size=200

agent_max_dvm_
table_cache_size

Specifies the maximum number of DVM tables to cache.
Possible values are any integer greater than 1. The
default value is 200 .

agent_max_dvm_table_
cache_size=200

agent_max_
lookup_table_
cache_size

Specifies the maximum number of lookup tables to
cache. Possible values are any integer greater than 1. The
default value is 200 .

agent_max_lookup_
table_cache_size=200

agent_max_queue_
size

Specifies the maximum size that internal OracleAS
InterConnect message queues can grow. Possible values
are any integer greater than 1. The default value is 1000 .

agent_max_queue_
size=1000

agent_
persistence_
queue_size

Specifies the maximum size that internal OracleAS
InterConnect persistence queues can grow. Possible
values are any integer greater than 1. The default value is
1000 .

agent_persistence_
queue_size=1000

agent_
persistence_
cleanup_interval

Specifies how often the persistence cleaner thread should
run. Possible values are any integer greater than 30000
milliseconds. The default value is 60000 .

agent_persistence_
cleanup_
interval=60000

agent_
persistence_
retry_interval

Specifies how often the persistence thread should retry
when it fails to push a OracleAS InterConnect message.
Possible values are any integer greater than 5000
milliseconds. The default value is 60000 .

agent_persistence_
retry_interval=60000

agent_pipeline_
to_hub

Specifies how to turn on or off the pipeline for messages
from the Bridge towards the hub. If set to false , the file
persistence is not used in that direction.

agent_pipeline_to_
hub=false

agent_pipeline_
from_hub

Specifies how to turn on or off the pipeline for messages
from the hub towards the Bridge. If you set the pipeline
to false , the file persistence is not used in that
direction.

agent_pipeline_from_
hub=false

Table 2–7 Adapter.ini Parameters

Parameter Description Example
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service_path Windows only. The value that the environment variable
PATH should be set to. Path is set to the specified value
before forking the Java VM. Typically, all directories
containing all necessary DLLs should be listed here.
Possible values are the valid path environment variable
setting. There is no default value.

service_
path=%JREHOME%\bin;
D:\oracle\ora904\bin

service_
classpath

The classpath used by the adapter Java VM. If a custom
adapter is developed and as a result, the adapter is to be
used to pick up any additional jars, add the jars to the
existing set of jars being picked up. Possible values are
the valid classpath. There is no default value.

service_
classpath=D:\oracle\
ora904\oai\904\lib\
oai.jar;
%JREHOME%\lib\i18n.ja
r;
D:\oracle\ora904\jdbc
\classes12.zip

service_class The entry class for the Windows service. The possible
value is
oracle/oai/agent/service/AgentService . There
is no default value.

service_
class=oracle/oai/agen
t/service/AgentServic
e

service_max_
java_stack_size

Windows only. The maximum size to which the Java
VM’s stack can grow. Possible values are the valid Java
VM maximum native stack size. The default value is the
default for the Java VM.

service_max_java_
stack_size=409600

service_max_
native_stack_
size

Windows only. The maximum size to which the Java
VM’s native stack can grow. Possible values are the valid
Java VM maximum native stack size. The default value is
the default for the Java VM.

service_max_native_
size=131072

service_min_
heap_size

Windows only. Specifies the minimum heap size for the
adapter Java VM. Possible values are the valid Java VM
heap sizes. The default value is the default Java VM heap
size.

service_min_heap_
size=536870912

service_max_
heap_size

Windows only. Specifies the maximum heap size for the
adapter Java VM. Possible values are any valid Java VM
heap sizes. The default value is 536870912 .

service_max_heap_
size=536870912

service_num_vm_
args

Windows only. The number of service_vm_arg<number>

parameters specified. Possible values are the number of
service_vm_arg<number>  parameters. There is no
default value.

service_num_vm_args=1

Table 2–7 Adapter.ini Parameters

Parameter Description Example
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service_vm_
arg<number>

Windows only. Specifies any additional arguments to the
Java VM. For example, to get line numbers in any of the
stack traces, set service_vm_arg1=java.compiler=NONE . If
there is a list of arguments to specify, use multiple
parameters as shown in the example by incrementing the
last digit starting with 1. Be sure to set the service_
num_vm_args  correctly. Possible values are any valid
Java VM arguments. There is no default value.

service_vm_
arg1=java.compiler=
NONE

service_vm_
arg2=oai.adapter=.aq

service_jdk_
version

Windows only. The JDK version the adapter Java VM
should use. The default value is 1.4.1 .

service_jdk_
version=1.4.1

service_jdk_dll Windows only. The dll the adapter Java VM should use.
The default value is jvm.dll .

service_jdk_
dll=jvm.dll

corba_port_
number

The CORBA port number on which the adapter CORBA
service listens. Generally, this port is allocated
dynamically. However, it can be configured to enable
access across firewall.

corba_port_
number=14000

encoding Character encoding for published messages. The adapter
uses this parameter to generate encoding information in
encoding tag of transformed OracleAS InterConnect
message. OracleAS InterConnect represents messages
internally as an XML document. The default encoding of
the XML document is UTF-8 . However, this encoding
can be configured using this parameter, which is
typically used when the OracleAS InterConnect10
message consists of characters not supported by UTF-8
and when the XMLParser  is unable to handle them.

encoding=JA16SJIS

Table 2–7 Adapter.ini Parameters

Parameter Description Example
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nls_date_format Format for date fields expressed as string. The following
pattern letters are defined. All other characters from A to
Z and from a to z are reserved.

Letter Date or Time Component Examples

G Era designator AD

y Year 1996 ; 96

M Month in year July ; Jul ; 07

w Week in year 27

W Week in month 2

D Day in year 189

d Day in month 10

F Day of week in month Number 2

E Day in week Tuesday ; Tue

a A.M./P.M. marker P.M.

H Hour in day (0-23) 0

k Hour in day (1-24) 24

K Hour in A.M/P.M. (0-11) 0

h Hour in A.M./P.M. (1-12) 12

m Minute in hour 30

s Second in minute 55

S Millisecond 978

z Time zone Pacific

The default date format is EEE MMM dd HH:mm:ss
zzz yyyy .

Note: This parameter specifies date format. It is
applicable for the date format only.

Date format pattern
dd/MMM/yyyy  can
represent 01/01/2003.

nls_date_
format=dd-MMM-yy

Multiple date format can be
specified as num_nls_
formats=2

nls_date_
format1=dd-MMM-yy

nls_date_
format2=dd/MMM/yy

Table 2–7 Adapter.ini Parameters

Parameter Description Example
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PeopleSoft 8 Adapter Parameters
The following table lists the parameters specific to the PeopleSoft 8 adapter.

nls_country This parameter is a valid ISO Country Code. These
upper-case and two-letter codes are defined by ISO-3166.
You can find a full list of these codes at a Web site, such
as,
http://www.chemie.fu-berlin.de/diverse/doc
/ISO_3166.html

The default Country code is US.

Note: This parameter specifies date format. It is
applicable for the date format only.

US

nls_language This parameter is a valid ISO Language Code. These
lower-case and two-letter codes are defined by ISO-639.
You can find a full list of these codes at a Web site, such
as,
http://www.ics.uci.edu/pub/ietf/http/relat
ed/iso639.txt

The default language code is en .

Note: This parameter specifies date format. It is
applicable for the date format only.

nls_language=en

Parameter Description Example

bridge_class This indicates the entry class for the PeopleSoft 8
adapter. Do not modify this value. There is no default
value.

bridge_
class=com.actional.oai.
Agent

Table 2–7 Adapter.ini Parameters

Parameter Description Example
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Starting the PeopleSoft 8 Adapter
On UNIX, start the PeopleSoft 8 adapter using the start  script in the following

directory:

$ORACLE_HOME/oai/9.0.4/adapters/ Application

 Type start, then press Enter.

On Windows, start the adapter from the Services window available from the Start

menu.

1. Access the Services window from the Start menu:

The Services window displays.

2. Select the OracleHomeOracleASInterConnectAdapter-Application service.

3. Start the service based on your operating system:

The PeopleSoft 8 adapter, in turn, automatically starts the publishing engine, a tool

for notifying foreign applications of additions, deletions, or updates to the native

application (in this case, PeopleSoft objects and databases).

On... Choose...

Windows NT Start > Settings > Control Panel > Services

Windows 2000 Start > Settings > Control Panel > Administrative Tools > Services

On... Choose...

Windows NT Choose Start.

Windows 2000 Right click the service and choose Start from the menu that
displays.

See Also: Oracle Application Server InterConnect Adapter Publishing
Engine User’s Guide
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Stopping the PeopleSoft 8 Adapter
On UNIX, stop the PeopleSoft 8 adapter using the stop  script in the following

directory:

$ORACLE_HOME/oai/9.0.4/adapters/ Application

Type stop, then press Enter.

On Windows, stop the adapter from the Services window available from the Start

menu.

1. Access the Services window from the Start menu:

The Services window displays.

2. Select the OracleHomeOracleASInterConnectAdapter-Application service.

3. Stop the service based on your operating system:

You may verify the stop status by viewing the oailog.txt  files in the appropriate

time stamped subdirectory of the log  directory within the adapter directory.

On... Choose...

Windows NT Start > Settings > Control Panel > Services

Windows 2000 Start > Settings > Control Panel > Administrative Tools > Services

On... Choose...

Windows NT Choose Stop.

Windows 2000 Right click the service and choose Stop from the menu that
displays.
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3
Supported PeopleSoft 8 Component

Interfaces

This chapter provides PeopleSoft-specific information for accessing PeopleSoft

Component Interfaces using OracleAS InterConnect. This chapter discusses the

following topics:

■ Working with OracleAS InterConnect and PeopleSoft Component Interfaces

■ Working with Component Interface

■ Exception Fields

■ Custom Component Interface

■ Creating a Subscribed Event
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Working with OracleAS InterConnect and PeopleSoft Component
Interfaces

OracleAS InterConnect provides a complete framework for e-Business application

integration. PeopleSoft users often configure PeopleSoft to employ OracleAS

InterConnect connectivity.

Working with Component Interface
When invoking a method on a Component Interface, the following warning

message may display:

java.lang.NullPointerException: PSProperties not loaded from file

This message indicates the pstools.properties  file cannot be found in the

CLASSPATH. For PeopleSoft 8 adapter to include this file, update the service_
classpath  parameter in adapter.ini  file.

Exception Fields
If an error occurs during a call, the exception field contains a detailed description of

the error. You can then propagate this error string to the calling application.

For example, if a client application tries to add a record to the PeopleSoft server and

the record with the same primary key already exists, a non-retryable error occurs.

The exception field contains the exception data, which can then be propagated back

to the client application.

See Also: You can find more information on this error in your

PeopleSoft Customer Support Web site. The resolution ID for this

issue is 703269.
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Custom Component Interface
A Component Interface declares the set of methods and properties that a

Component Interface supports, but it does not implement the behavior or

properties. The OracleAS InterConnect PeopleSoft 8 adapter provides five standard

methods for Component Interfaces:

■ Bind

■ Create

■ Find

■ Get

■ Update

Before using Component Interfaces you must upload a custom Component

Interface.

See Also: "Importing the Custom Component Interface"  on

page 5-1



Custom Component Interface

3-4 Oracle Application Server InterConnect Adapter for PeopleSoft 8 Installation and User’s Guide

Creating an Implemented Procedure
1. Start iStudio.

2. Right-click Implemented Procedures and select New under the Applications

folder.

Figure 3–1 Creating an Implemented Procedure
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The Implement Wizard—Select a Procedure dialog box is displayed.

Figure 3–2 Implement Wizard - Select a Procedure

3. Select a procedure and click Next.

The Define Application View dialog box is displayed. Use this dialog to import

attributes from PeopleSoft. To import attributes, you must log in to PeopleSoft.

After logging in to PeopleSoft and importing attributes, the Define Application

View dialog box is populated with the selected components.

See Also: "Importing Attributes" on page 3-8
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4. Click Next in the Define Application View screen.

Figure 3–3 Implement Wizard - Define Application View

5. Click Next.
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The Define Mappings Arguments dialog box is displayed.

Figure 3–4 Implement Wizard - Define Mapping:IN Arguments

6. Click New.

7. Define the mappings and click Finish.
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Importing Attributes
To import attributes from PeopleSoft:

1. Click Import and select PeopleSoft on the Define Application View dialog.

The PeopleSoft Login dialog box is displayed.

Figure 3–5 PeopleSoft Login

2. Enter information in the following fields:

■ Application Server Name—Enter a valid application server name.

■ Operator ID—Enter a valid operator ID.

■ Password—Enter a valid password.

■ PeopleSoft Version—Select 8.1x from the dropdown list.

This disables the Data Source Dialog and enables the Component Interface

Host.

■ Component Interface Host—Enter the host name and port number of the

machine hosting the Component Interfaces, for example,

//PEOPLE8:9000 .

Note: If you do not have a valid ID and password, contact your

PeopleSoft administrator.
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3. Click OK.

The Component Selector is displayed.

4. Expand the Component Interfaces folder.

Figure 3–6 Component Selector

5. Double-click a method to expand the tree and select a method.

6. Click OK.

The selected method and its attributes display on the Define Applications
View dialog.
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Creating a Subscribed Event
To create a subscribed event in iStudio:

1. Start iStudio.

2. Right-click Subscribed Event and select New under the Applications folder.

Figure 3–7 Creating a Subscribed Event
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The Subscribe Wizard—Select an Event dialog box is displayed.

Figure 3–8 Subscribe Wizard - Select an Event

3. Select the Application and Message Type from the dropdown menus.

4. Select an Event and click Next.
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The Define Application View dialog box is displayed.

Figure 3–9 Subscribe Wizard - Define Application View

5. Click Import and select PeopleSoft.

The Define Application View dialog box is displayed. Use this dialog to import

attributes from PeopleSoft. To import attributes, you must log in to PeopleSoft.

See Also: "Importing Attributes" on page 3-8
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After logging in to PeopleSoft and importing attributes, the Define Application

View dialog box is populated with the selected components.

Figure 3–10 Subscribe Wizard - Define Application View

6. Click Next.
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The Define Mapping dialog box is displayed.

Figure 3–11 Subscribe Wizard - Define Mapping

7. Click New to define mappings and click Finish.
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4
Component Interface Methods

This chapter provides information on OracleAS InterConnect PeopleSoft 8 adapter’s

Component Interface standard and user-defined methods. This chapter discusses

the following topics:

■ OracleAS InterConnect Component Interface Standard Methods

■ OracleAS InterConnect Component Interface User-Defined Methods

■ Basic Data Types
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OracleAS InterConnect Component Interface Standard Methods
OracleAS InterConnect provides five standard methods for Component Interfaces:

■ Create

■ Find

■ Get

■ Update

■ Bind

Create
Use the Create  method to create a new record using a set of unique keys and

specified properties.

Syntax
Create (key1, key2, ... keyn, properties)

where:

■ key  (in/out parameter)—The individual key parameters (key1, key2, ..
keyn ) must be supplied. This set of keys must not exist in the server database,

that is, they must be unique. These keys correspond to the set of Create Keys
as defined for the particular Component Interface.

■ properties  (structure)—Contains a complete structure of the Component

Interface’s properties, which is inserted into the record created with the

specified keys.

Description
In some situations, it is common practice to call Create()  without a set of explicit

keys, but the Create  function returns them. This behavior is supported with

PeopleCode that is triggered on the server. For example, to create a Purchase Order,

the client may not know what the next available PO number is. By specifying NEXT
as the PO number key, the call triggers PeopleCode, which determines the next

available PO number. This information must be returned to the calling client, via

the in/out key parameters.

For this mechanism to work, the key must also be a property at level 0. Otherwise,

the original key is returned.
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Find
Use the Find  method to return a list of keys that satisfy the supplied partial search

keys. If the Component Interface has only one instance, which means there is no

key, then the Find()  function will not be generated

Syntax
Find (partialKey, keyList)

where:

■ partialKey  (structure)—Where the individual keys are optional.

■ keyList  (output parameter)—A list of keys that matches the partialKey .

These keys correspond to the set of Find Keys  as defined for the particular

Component Interface.

Description
When specifying the partial keys, it is possible to use the same wildcard search

available from the PeopleSoft internal Find()  function. For example, the partial

ACCOUNT key of "11" returns all ACCOUNT keys that start with "11", whereas "%40"
returns all ACCOUNT keys that contain "40" anywhere within the key. A partial key

"_4_4 " returns all ACCOUNT keys with the character "4" in the second and fourth

positions.

OracleAS InterConnect’s Find()  method is provided if PeopleSoft’s Find  function

in the Component Interface is enabled and Get  keys are available.

Note: OracleAS InterConnect’s Create()  method is provided if

PeopleSoft’s Create  and Save  functions in the Component

Interface are enabled.

See Also: The Get()  function on page 4-4

Note: With the current implementation of the PeopleSoft Server, if

more than 300 items match the search criteria, the call will fail. This

is a restriction of the PeopleSoft server.
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Get
Use the Get  method to retrieve properties based on the input key parameters

(key1, key2, … keyn ). The output parameter is a structure containing the

properties of the record that matches the key parameters. If the Component

Interface has only one instance (that is, there is no key) then the Get  function does

not contain any key parameter

Syntax
Get (key1, key2, ... keyn, properties)
Get (key1, key2, ... keyn, getHistoryItems, properties)

where:

■ All the key  parameters must be supplied. This set of keys must exist in the

server database, otherwise an error will occur. These keys correspond to the set

of Get Keys  as defined for the particular Component Interface.

■ properties  (structure)—Contains a complete structure of the Component

Interface’s properties, which is returned upon completion of the call.

Description
If the properties of the Component Interface contain effective dated items below

level 0 (that is, a key field with a name of EFFDT), the getHistoryItems
additional parameter is required. This parameter is of type Boolean. If it is set to

True then all effective dated items are returned as a sequence (which could be

embedded in any level). These include all past effective dated items, the current

effective dated item, as well as all future effective dated items. If the

getHistoryItems  parameter is set to False, only the current and all future

effective dated items are returned. If subsequent calls to update on the same

instance are to be made, then getHistoryItems  should be set to False.

If the Component Interface does not have any key, as in the case where only one

instance can exist, then the Get()  method will have the form:

Get(properties)

See Also: The Find()  function on page 4-3

See Also: The Update()  method on page 4-5

See Also: PeopleSoft documentation for more information on

effective dated items
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Update
Use the Update  method to update properties based on the input key parameters

(key1, key2, … keyn ).

Syntax
Update (key1, key2, ... keyn, properties)

where:

■ All the key  parameters must be supplied. This set of keys must exist in the

server database, else an error will occur. These keys correspond to the set of

Get Keys  as defined for the particular Component Interface.

■ properties  (structure)—Contains a complete structure of the Component

Interface’s properties, which replaces the existing properties in the database.

Description
When calling this function, the properties of the record corresponding to the keys

are replaced by the properties  input parameter. All collections with the original

records are deleted and replaced by those in the input parameter. The sizes of these

collections do not have to match, as the procedure within Update  is to delete all

existing collection items and then insert the given ones.

If the properties of the Component Interface contain effective dated items, then the

properties  parameter must contain all future effective dated items, as the

original list is replaced. This provides the mechanism for adding and deleting

future effective dated items. However, if the properties also contain past effected

items, an error is returned, as past effective dated can not be modified. If the current

effective dated item is also included, it is ignored. This permits the client to call

Get()  with the getHistoryItems  parameter set to False, modify any future

effected items or add new future effective dated items, and then pass the structure

as the parameter for the Update()  function.

If the Component Interface does not have any key, as in the case where only one

instance can exist, then the Update()  method will have the form:

Update(properties)

Note: OracleAS InterConnect’s Get()  method is provided if

PeopleSoft’s Get  function in the Component Interface is enabled.
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Bind
Use the Bind  method to bind a Component Interface object to a specific credential.

Syntax
Bind (host, user, password)

Description
The Bind  method permits the client to use an explicit credential to access a given

Component Interface object. It returns a bind object which has the associated

credential. For example:

Myobject = new myCIObject
Set MyBindObject = Myobject.Bind(myHost, me, myPassword)
MyBindObject.Get(key, properties)

The access of the returned object and its methods are based on the credential as

specified by the Bind  method. This function allows for multiple credentials from a

single client, for different objects.

If a Component Interface object is invoked without calling Bind() first, the

credential used is the one specified in the profile.

Note: OracleAS InterConnect’s Update()  method is provided if

PeopleSoft’s Get  and Save  functions in the Component Interface

are enabled.
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OracleAS InterConnect Component Interface User-Defined Methods
OracleAS InterConnect supports user-defined methods in Component Interfaces.

The signatures are of the form:

myRet=myCI.myMethod(parameter1, parameter2, ...)

where:

■ parameter1 , parameter2 —Input parameters

■ myRet—The return value

The parameters can only be input parameters to the method. Only one value can be

returned from the method as the return parameter.

The Component Interface that contains user-defined methods must have the

PeopleSoft’s Find  and Get  functions enabled.
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Basic Data Types
Table 4–1 describes how PeopleSoft basic data types map to OracleAS InterConnect

types.

Table 4–2 identifies the range of four basic types.

Table 4–1 Basic Types

PeopleSoft Basic Types Interconnect Types

Char(<n>) String

Long(<n>) String

Nbr(<n>, 0) Integer, Double, String

Sign(<n>, 0) Integer, Double, String

Collection Array

Component Interface Properties Complex structures

Time Date

Date Date

Date Time Date

Table 4–2 Range of Basic Types

Data Type Range

Char(<n>) Any string of <n>  characters. <n>  is between 1 and 254 .

Long(<n>) Any string of <n>  characters. <n>  is between 0 and 64000 .
Long(0)  is an unbounded string.

Nbr(<n>, <d>) Unsigned value with <n>  digits before the “.” and <d>  after
Nbr(3.2)  has a range of 0 to 999.99 . The maximum
precision for this type is always the precision of a java float.

Sign(<n>, <d>) Signed value with <n> digits before the “.” and <d>  after
Sign(3.2) has a range of -999.99 to 999.99 . The maximum
precision for this type is always the precision of a java float.
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5
Importing the Custom Component Interface

This chapter provides information for importing the custom Component Interface.

This chapter discusses the following topic:

■ Importing the Custom Component Interface
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Importing the Custom Component Interface
To utilize the PeopleSoft 8 adapter, a modification to the PeopleSoft server is

required. The custom component, GET_CI_INFO, must be imported into

PeopleSoft. Once the custom Component Interface is imported, Component

Interfaces can be browsed within PeopleSoft. This task is only required on the initial

setup to use OracleAS InterConnect.

The following instructions explain how to manually import the custom Component

Interface, which will allow you to browse Component Interfaces within PeopleSoft

8.

Creating the Component Interface
The following steps provide a brief overview from a PeopleSoft application.

From the Application Designer:

1. Select Start->Programs->Peoplesoft->Application Designer.

2. Select a 3-tier Connection Type and click OK.

 For example, select Application Server from the drop down list.

3. Select File->New in the Application Designer.

The New dialog box is displayed.

Figure 5–1 Selecting a Component Interface

4. Select Component Interface and click OK.

5. Click Select in the Select dialog.

A list of Component Interfaces is displayed.

See Also: PeopleSoft on-line help for complete instructions
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6. Select any simple component, for example, SIMPLECALENDAR and click Select.

The custom methods to be installed do not use any properties of the

Component Interface.

A component is loaded into the screen.

7. Select File->Save As.

8. Type GET_CI_INFO in the Save Name As field and click OK.

Figure 5–2 Entering a Component Name

9. Right-click any method of your new Component Interface.

A popup menu appears.

10. Select View PeopleCode.

A text editor window is displayed.

11. Access the <install_directory>\config\PeopleSoft\  directory and

copy the contents of get_ci_info.pc  into the text editor window.

12. Select File->Save to save the new Component Interface, GET_CI_INFO.

Setting Security
After importing the custom GET_CI_INFO PeopleSoft Component Interface on

PeopleSoft, set the security settings for the GetCINamespace , GetDetails , and

GetCollections  methods for OracleAS InterConnect.

In the Application Designer:

1. Select Go->PeopleTools->Maintain Security.

The Maintain Security dialog box is displayed.

2. Select Use->Permission Lists->Component Interface->Update/Display.

The Update/Display — Permission Lists dialog box is displayed.
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3. Type an applicable permission list item in the Permission List text box, for

example, ALLPNLS, and click OK.

To retrieve a list of possible permission lists, click OK.

4. Scroll down the list of Component Interfaces until you find the following line:

Click On This Row To Enter Data .

5. Select this row and type GET_CI_INFO to add a new Component Interface in

the Maintain Security - Use - Permission Lists dialog.

Figure 5–3 Component Interface Permission LIst

6. Select Edit from the menu.

A dialog box containing the permissions for this Component Interface is

displayed.

7. Click Full Access (All) to set Full Access to all methods.

8. Click OK to exit the Designer.
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The PeopleSoft server is set up. You can now browse PeopleSoft containing

Component Interfaces.
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6
Using the Configuration Editor

This chapter describes how to use the Configuration Editor to configure the

PeopleSoft 8 adapter to use Component Interfaces. The Configuration Editor is only

used at runtime. This chapter discusses the following topics:

■ Configuration Editor

■ PeopleSoft Login

■ Data Formats

Note: Profiles and Deployment are sensitive to the Master Key

setting. If using a shared machine, before accessing the

Configuration Editor, ensure the Master Key is set to either that of

User1 or create a new Master Key for your profiles. Refer to Oracle
Application Server InterConnect Adapter Configuration Editor User’s
Guide, "Using the Master Key Setting Tool" for more information on

the Master Key.
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Configuration Editor
To configure settings for the PeopleSoft 8 adapter you must access the PeopleSoft

Configuration Editor as follows:

1. Change directories to the installation directory using a command prompt.

2. Type configeditor  and press Enter.

The Configuration Editor displays.

3. Select PeopleSoft to edit the PeopleSoft configuration settings for your profile.

4. Click Profile.

5. Select Set As Default from the Profile drop down menu.

6. Select your new profile.

Note: Under some circumstances you may wish to run your

adapter under a profile other than iStudio. For example, running

the adapter under a different profile is required if you run two

instances of the PeopleSoft 8 adapter on the same machine. You can

have two instances of the same type of adapter if these instances

connect to different back-end system installations. To accomplish

this, create a new profile using the configuration editor and enter

the settings for this new profile. The name of the new profile should

be the same as the name of the application. For example, if your

application is called APP2, create a profile called APP2. Now APP2
uses the settings in the profile called APP2, whenever it runs.
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Figure 6–1 Configuration Settings Editor

7. Click OK.

8. Select File > Exit to exit the Configuration Editor after completing the setup.
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PeopleSoft Login
The Login branch is only available for user-defined profiles and provides

connection information to a PeopleSoft system. You must specify the Application

Server Name, Operator ID, and the Password.

Figure 6–2 Login Panel

Table 6–1 Login Panel Configuration Settings

Login Panel Fields Field Description

Application Server Name This field is not required for Component Interfaces.

Operator ID Insert the identification you use to access the PeopleSoft
application.

Password Enter your PeopleSoft password. The Password is only
editable under specific user-defined profiles.

PeopleSoft Version Select the version of your PeopleSoft application in the tree
view.
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Once the PeopleSoft version is selected, the following page displays in the right

panel.

Figure 6–3 Login Screen - Component Interface

Table 6–2 Login Panel Component Interface Configuration Settings

Login Panel Fields Fields Descriptions

Component Interface Host Set the URL path to the PeopleSoft 8 application,
//<host>::<port> .

For example, //PeopleSoft8::9000 .

This field specifies the host and port on which the PeopleSoft
server is waiting for incoming requests.

Interactive Mode In a production environment, the checkbox must remain
unchecked. This parameter is useful for debugging when
developing or testing. It enables the PeopleSoft Server to return
better exception messages when Component Interface access
fails.

Note: PeopleSoft scalability only applies to PeopleSoft 7.5
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Data Formats
The Data Formats page provides conversion information for date and time strings

used in messages. This page is for those applications requiring a date, for example,

Automation applications. The information is determined by the PeopleSoft system.

Figure 6–4 Data Format Panel

Table 6–3 Data Format Panel Configuration Settings

Data format Panel Fields  Field Description

Date The format is MM/DD/YYYY.

Time The format is hh:mm:ssAA  where AA is either AM or PM.

Date Time The format is MM/DD/YYY hh:mm:ssAA  where AA is either
AM or PM.
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